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5
A network connects two or more computers, 
allowing users to exchange files, collaborate 
on projects, share printers, share an Internet 
connection, and more. All you need to set up 
a network is a broadband connection (for the 
Internet part), one or two hundred dollars’ 
worth of equipment, and a little patience. But 
wait… it gets better. You don’t even have to rip 
apart the walls to lay cable. If you’re ready to 
cut the proverbial cord, you can build a wireless 
network (or expand your existing wired setup 
with wireless technology) and surf the Internet 
from your back porch.

That’s the good news. The bad news is that while setting up 
home networks isn’t too difficult, you’ll likely face a whole slew 
of annoyances as you attempt to share your Internet connection, 
printers, drives, and folders. Of course, you’ll also need to tackle 
knotty logon, password, and security issues with your network. 
Ready? Let’s dig in….

Wireless and 
Networking
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S H A R I N G  A N D  S E C U R I T Y

Network Two Computers
THE ANNOYANCE: I want to set up a home network, but I can’t figure out what 
I need to make it work. I thought Gosford Park was confusing, but this is 
ridiculous!

THE FIX: Well, to start with you need at least two computers, and a way to 
connect them. If you’re assembling a wired Ethernet network, you’re in 
luck: almost every PC manufactured after 1998 or so has a built-in Ethernet 
Network Interface Card (NIC). (Many newer PCs—and nearly all laptops 
produced after 2003—also include wireless cards.)

For the most part, network cables have gone the way of the dinosaur, 
because of the convenience offered by wireless networking. But cables still 
offer a fast, hassle-free connection that’s susceptible to neither interference 
(see “Increase Range and Improve Reception”) nor intruders (see “Surf 
Safely at the Coffee Shop”). If you decide to go the cable route, you’ll need 
category-5 patch cables to connect each PC to your router. (If you’re set-
ting up a wireless network, you’ll also need one of these cables to connect  
the wireless router to your DSL or cable modem, as discussed later in this 
chapter.) Or, for a quick-and-dirty two-PC network without a router, a 
single category-5 crossover cable will do in a pinch.

Of course, you’ll also need a router, which serves as a hub for the afore-
mentioned cables. (If you want to connect any computers wirelessly, you’ll 
need to get a wireless router that includes a built-in access point.) Routers 
let you share an Internet connection among any number of computers, and 
even offer protection from the outside world by way of a built-in firewall (for 
more on firewalls, see “Set Up a Wireless Network”). 

After you’ve properly installed the drivers for your network adapters (wire-
less or otherwise), Windows should do the rest without much help from 
you—but unfortunately, it doesn’t always work out that way. (If you run 
into trouble installing the network adapters or other hardware, turn to 
Chapter 6.)

You can fix most simple configuration problems by completing the cum-
bersome Network Setup Wizard on all PCs in your network. Open the 
Network Connections control panel, and click the “Set up a home or small 
office network” link on the left side. (Or, if you don’t see the Network Tasks 
pane, double-click the Network Setup Wizard icon.) Click the Next button 
on the first few pages, and then answer the questions as follows:

 • If you’re asked about disconnected network hardware, place a check-
mark next to the “Ignore disconnected network hardware” option, and 
click the Next button.

 Network Two Computers
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 • On the “Select a connection method” page, choose Other, and click the 
Next button.

 • On the “Other Internet connection methods” page, choose the “This 
computer connects to the Internet directly…” option, and then click the 
Next button.

 • When asked for a computer name, choose a unique, one-word name for 
your PC (each computer must have a different name), leave the descrip-
tion field blank, and click the Next button.

 • On the “Name your network” page, Windows will automatically name 
your network “MSHOME,” even if you’ve previously typed a different 
network name. Type a new name if you want, but make sure all the 
other PCs on your network share the same network name. Click the 
Next button.

 • On the “File and printer sharing” page, choose the “Turn on file and 
printer sharing” option if you want to exchange files over your network 
(see “Share Files with Other Computers”), and then click the Next but-
ton.

Proceed through the following (mostly pointless) screens by clicking the 
Next button, and when you arrive at the “You’re almost done” page, choose 
“Just finish the wizard.” Click the Next button, and then click the Finish 
button. Whew!

Back in the Network Connections 
window, select View→Details to 
show the pertinent information. 
Right-click the “LAN or High-Speed 
Internet” connection you’re using, 
and select Properties. Then, select 
Internet Protocol (TCP/IP) from the 
list and click the Properties button 
to show the Internet Protocol (TCP/
IP) Properties dialog box (see Figure 
5-1).

Figure 5-1. You may have to manually 
configure TCP/IP properties to get your PC 
noticed on your network.

Network Two Computers
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In most cases, selecting the “Obtain an IP address automatically” and 
“Obtain DNS server address automatically” options will suffice. If, how-
ever, you can’t get your network to work with automatic addressing, try the 
following settings:

 1. Choose the “Use the following IP address” option.

 2. In the IP address field, type 192.168.1.100. (When you configure the 
second PC on your network, type 192.168.1.101 in the IP address box. 
For the third PC, type 192.168.1.102, and so on.)

 3. In the Subnet mask field, type 255.255.255.0.

 4. In the Default gateway field, type the IP address of your router (usually 
192.168.1.1 or 192.168.0.1).

 5. In the “Preferred DNS server” and “Alternate DNS server” fields, type 
the IP addresses of your ISP’s primary and secondary DNS servers, 
respectively. Contact your ISP or visit your ISP’s web site for this infor-
mation.

 6. Click OK in both boxes when you’re done.

These “static IP” numbers will help ensure that all the PCs on your network 
can communicate reliably with each other. For best results, set static IP 
addresses on all the PCs on your network.

Return to the Network Connections window when you’re done. The Status 
column shows whether or not a connection has been established (e.g., 
“Connected” or “Network cable unplugged”). 

If it says “Acquiring network address,” it means Windows is in the process 
of establishing a connection; if you see this for more than, say, 10 seconds, it 
means your router isn’t automatically assigning your PC a proper IP address. 
If you’re connecting wirelessly, this error typically appears when you haven’t 
supplied the necessary WPA or WEP security key (see “Connect to a 
Wireless Network”). For wired networks, this error could indicate a prob-
lem with the router, the cabling, or the NIC and its drivers. If the “Obtain 
an IP address automatically” option is selected in the TCP/IP Properties 
dialog box for your network connection, try specifying a static IP address, 
as described earlier, to fix this problem.

The addresses you type for the 
subnet mask, gateway, and 
DNS servers should be the same 
for all PCs on your network.

N O T E

Often, networks don’t work because Windows and your router fail to 
negotiate the correct addresses automatically. The first three numbers 
in each PC’s IP address (e.g., 192.168.1.) must exactly match the first 
three numbers in the IP address of your router—usually 192.168.1.1 or 
192.168.0.1—which you can get from your router’s documentation. Only 
the last number (e.g., 100, 101, 102) must be different for each PC.

N O T E
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If the status column says “Limited or no connectivity,” it usually means a 
connection has been established but your IP address is incorrect; make sure 
that the first three numbers in your PC’s IP address match the first three 
numbers in your router’s IP address, and that the fourth is different from 
any other PC on your network.

Share Files with Other Computers
THE ANNOYANCE: I need to access a bunch of documents on my office desktop 
PC from my laptop. I want to open the files over the network and avoid the 
whole CD/floppy/USB drive shuffle, but I can’t get it to work.

THE FIX: There are a handful of steps you need to take to configure your PCs 
before you can exchange files between them on your network:

 1. Complete the Network Setup Wizard on each PC on your network (see 
“Network Two Computers”), and make sure you enable file sharing 
when prompted.

 2. If you’re using Windows XP Professional or Windows XP Media Center 
Edition, open Windows Explorer, select Tools→Folder Options, and 
choose the View tab. Remove the checkmark next to the “Use simple 
file sharing (Recommended)” option, and click OK. (This option is not 
available in Windows XP Home Edition.)

 3. The next step is to formally share the appropriate folder on the main 
PC. Open Windows Explorer and navigate to the folder containing the 
files you want to open remotely. Right-click the folder, select Properties, 
and choose the Sharing tab.

In Windows XP Home, check the “Share this folder on the network” 
box. In Windows XP Professional and Media Center Edition, select the 
“Share this folder” option (see Figure 5-2). (If Windows asks whether 
you understand the “risks,” confirm that you indeed wish to enable file 
sharing.)

Enter a descriptive name in the “Share name” field. This is the name 
used for your folder when you view it over the network.

If you’re using Windows XP Home Edition and the “Share this folder 
on the network” option is grayed out, remove the checkmark next to the 
“Make this folder private” option. If that option is grayed out as well, 
click the “another folder” link at the bottom of the window, remove the 
checkmark next to the “Make this folder private” option on the window 
that appears, and click OK. Then return to the folder you want to share 
and try again.

N O T E

Share Files with Other Computers
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 4. If you want to be able to remotely modify, delete, or create new files in 
this folder, you must set the permissions accordingly. In XP Home, just 
place a checkmark next to the “Allow network users to change my files” 
option. In XP Professional, click the Permissions button and follow the 
steps in “Protect Shared Files,”

 5. When you’re done, click OK. A little hand icon will appear over the yel-
low folder icon to identify it as shared.

But you’re not finished yet! For the sake of security, the desktop computer 
holding the files you want to share must have a password associated with 
the owner of the files, as described in “Protect Shared Files.” (By default, 
user accounts don’t have passwords in Windows XP.) What’s more, users 
trying to access those files remotely must be able to provide the same user-
name and password. This user validation may be transparent or may require 
a login, depending on who owns the files:

 • When you first connect to the PC with the shared files, Windows will 
check to see if the usernames of the owner of the shared files and the 
one using the remote PC are the same. If the usernames are differ-
ent, Windows will ask for a username and password. For example, if 
“Jane” on one computer tries to read the files on a computer belonging 
to “Rutiger,” Jane will be required to type Rutiger as well as Rutiger’s 
password in order to access the shared files.

Figure 5-2. To allow the exchange of files 
over a network, use the “Share this folder 
on the network” option in XP Home Edition 
(left) or the “Share this folder” option in XP 
Professional/MCE (right).

If you’re using Windows XP 
Professional and you want to 
share the entire drive (not just 
the folder), see “Share an Entire 
Drive,” later in this chapter.

N O T E
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 • If the username is the same on both PCs, the passwords must match. 
For example, if “Rutiger,” while logged into one computer, tries to 
access files belonging to “Rutiger” on another computer, and each 
Rutiger account has precisely the same password, Windows will grant 
access to the files without any prompt at all. But if the passwords on 
both accounts don’t match exactly, Windows may not let you in, even 
if you type the correct username/password combination into the login 
box. The solution: just change one of the passwords so they match. 

Once you have the user accounts and passwords straightened out on all 
your PCs, open Windows Explorer on the remote computer—the one 
accessing the files on that desktop PC—and navigate to the My Network 
Places folder, shown in Figure 5-3.

You may see several familiar-looking folders in My Network Places, such 
as My Documents on Laptop or C on Desktop. Windows Explorer auto-
matically creates these folder shortcuts to provide easy access to frequently 
accessed shares. If you don’t see the folder you want here, don’t panic; just 
open the Entire Network folder, then Microsoft Windows Network, then the 
name of your workgroup (e.g., MSHOME), and finally the name of the PC 
with the files you want (e.g., Desktop).

Once you choose a password, 
Windows will ask you for it 
every time you power up your 
PC. To skip this step, see “Log 
in Automatically.”

N O T E

Figure 5-3. Use the My Network Places folder to access shared folders on other PCs.

Share Files with Other Computers
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Inside the folder, you’ll find a listing of the folders, printers, and (for some 
reason) scheduled tasks shared on that PC. Open any shared folder to 
access the files therein as though they were stored on your own hard disk: 
copy or move via drag and drop, rename, delete, or just double-click to open 
the files in place.

Find Missing Computers in My Network Places
THE ANNOYANCE: I’m trying to open a file on another PC on my network, but it 
doesn’t show up in My Network Places. This is driving me crazy!

THE FIX: This is a really common problem, and one that is not always easily 
solved.

First, a remote computer may not appear in My Network Places if it doesn’t 
have any files or printers shared. See “Share Files with Other Computers” 
to set up file sharing or “List All Your Shared Folders” to see what’s being 

shared on any PC.

Shared folders on remote PCs can show up in two places 
in the My Network Places folder: shortcuts to previ-
ously accessed folders sometimes appear right in the My 
Network Places folder itself, but for a complete list, navi-
gate to \Entire Network\Microsoft Windows Network, 
open your network (e.g., MSHOME), and then open any 
PC to show its shared folders and printers.

Also, you may or may not see a PC that is in another 
workgroup in the Microsoft Windows Network folder 
in My Network Places. If you don’t see the other work-
group, and you have control over the other PC, change 
its workgroup name to match the rest of the PCs on your 
network. Open the System control panel (or right-click 
My Computer and select Properties), and then choose 
the Computer Name tab. The name of your PC, as well 
as the workgroup to which it belongs, is shown here (see 
Figure 5-4); click the Change button to rename the PC 
or join a different workgroup. All the PCs on your net-
work should belong to the same workgroup, but no two 
PCs should share the same computer name.

If you don’t see the other PC in your workgroup, see “Find Missing Computers 
in My Network Places.” If you get an “Access is denied” error at any point, it 
means the owner of the files on the other computer has set permissions to keep 
you from messing with his data. If you have control over the other PC, see 
“Protect Shared Files” for help.

N O T E

Want to share bits of data 
without hassling with files? 
The Copycat utility, free from 
http://www.r2.com.au, auto-
matically transfers the contents 
of your clipboard (used to hold 
data that you cut or copy) to 
all the PCs on your network. 
Just highlight some text on 
one machine, and press Ctrl-
C; then, on another PC, press 
Ctrl-V to paste it anywhere you 
like!

N O T E

Figure 5-4. Use System Properties to 
change your PC’s computer name and 
workgroup.

 Find Missing Computers in  
My Network Places
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If the workgroup matches but the PC still doesn’t show up, one trick that 
often works is to type the name of the PC directly into Windows Explorer’s 
address bar. (If you don’t see the address bar, select View→Toolbars→
Address Bar.) Erase the text in the address bar, and type two backslashes 
followed by the missing PC’s name, like this:

\\misterx

where misterx is the name of the remote PC. Press Enter, and with luck—
and about 5–10 seconds of patience—Windows should list the shared fold-
ers on the remote computer.

If you still can’t see the PC, make sure the network is functioning on both 
the remote computer and the local PC (the one you’re sitting in front of). If 
they’re both connected to a router that provides a shared Internet connec-
tion, for instance, open a web browser on each PC to test the connection. If 
you can load a web site, the network is working.

Often, you can force stubborn computers to show up by setting a static 
IP address for each PC on your network, as described in “Network Two 
Computers.” Then use the ping command to test connectivity. Select Start→
Run, type cmd, and click OK to open a Command Prompt window, and then 
type:

ping 192.168.1.107

In this example, 192.168.1.107 is the IP address of the remote PC; replace 
this with the appropriate address. If you get a reply like the following from 
the remote machine, it means your computer can see and successfully com-
municate with that machine on your network:

Reply from 192.168.1.107: bytes=32 time=3ms TTL=64

If, on the other hand, you see a timeout message like this, the connection 
is broken:

Request timed out.

File sharing will not work as long as ping returns this error, so your best bet 
is to check your hardware and IP address settings instead of toiling with the 
My Network Places folder.

If the network checks out but you still can’t see the remote PC, try restarting 
both computers and resetting your router (refer to your router’s instructions 
for the reset procedure).

If one of the PCs is running an older operating system (particularly 
Windows 95 or 98), see “Connect to a Windows 9X/Me PC.”

If all else fails, it’s likely a problem with the hardware. Try replacing the 
cables if you have a wired network, or see “Increase Range and Improve 
Reception,” later in this chapter, if you have a wireless network. For help 
with updating drivers, replacing network adapters, and resolving hardware 
conflicts, see Chapter 6.

Find Missing Computers in  
My Network Places
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Protect Shared Files
THE ANNOYANCE: I want to share a bunch of files with other PCs on my net-
work, but I’m worried that doing so will allow anyone to see them. How do 
I protect my data?

THE FIX: Any computer connected to your PC over a network—including the 
several billion machines on the Internet—may be able to access the files in 
your shared folders. Thus, the best way to protect your data is to not share 
it in the first place. If you need to share files, exclude folders that contain 
particularly sensitive data. See “List All Your Shared Folders” for a compre-
hensive list of shared folders on your PC, and then take advantage of XP’s 
security features, such as they are, to protect the rest of your files.

The first thing you need to do is set a password for your user account. Open 
the User Accounts control panel, select your account from the list, and then 
click “Create a password.” Type your password twice, followed by a clue to 
act as a reminder down the road (you may well need it), and then click the 
Create Password button when you’re done. Thereafter, anyone wanting to 
access your files from another computer on your network will have to sup-
ply the password (with some exceptions for Windows XP Professional).

Now, unless you employ some sort of firewall anyone outside your local 
network—namely, everyone on the Internet—can access your data (and 
yes, no matter how uninteresting you may think the contents of your PC are, 
this can happen to you). Windows XP comes with the “Windows Firewall,” 
a feeble software-based solution, but nothing beats a hardware firewall 
placed between you and the rest of the world. If you don’t have one already, 
get yourself a router for this purpose, as described in “Set Up a Wireless 
Network.”

For any more protection, you’ll need to use permissions, which are special 
settings that control precisely who can do what to your files. Permissions 
are available only in Windows XP Professional (and Media Center Edition); 
if you’re using Windows XP Home, your ability to protect your data effec-
tively stops here.

On an XP Pro system, every file, folder, and drive has two sets of permis-
sions you can set: permissions for local users (other people sitting at your 
PC), and permissions for anyone accessing your files through a shared 
folder. To set the permissions for a shared folder, right-click the folder, select 
Properties, choose the Sharing tab, and then click the Permissions button. 

If you’re using a wireless network, anyone within range may be able to join 
your network and access your files, unless you follow the steps in “Surf Safely 
at the Coffee Shop.”

W A R N I N G

What About 
Encryption?

Windows XP Professional also 
has some built-in data encryp-
tion features, but encryption 
offers no more protection 
than restrictive permissions 
when using shared fold-
ers. Rather, encryption is 
designed to protect your data 
from those who use your PC 
directly, either by sitting in 
front of it or by remote con-
trol using Terminal Services 
(a.k.a. Remote Desktop). For 
more information about the 
ins and outs of encryption, 
as well as Remote Desktop, 
see O’Reilly’s Windows 
XP Annoyances for Geeks, 
Second Edition, by David A. 
Karp .

 Protect Shared Files
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The Share Permissions window, shown in Figure 5-5, 
shows a list of configured users in the top list, and the 
specific things the selected user is allowed to do down 
below.

First, make sure your own username appears in the 
upper list; if it doesn’t, or if it merely shows “Everyone” 
(like the one in Figure 5-5), click the Add button. Type 
your username—or the username of the person you 
want to be able to access your stuff—in the “Enter the 
object names to select” field, and then click the Check 
Names button. If Windows underlines what you’ve 
typed, the username is okay; otherwise, you’ll get a 
“Name not Found” message. Click OK when you’re 
done adding names.

Next, highlight your username in the “Group or user 
names” list, and place checkmarks in the boxes in the 
Allow column below as you see fit. Want others to be 
able to read the files in this folder but not change any of 
them? Put a checkmark in the Read box, but not in the 
Full Control or Change boxes.

If you want to deny any user access to your files—particularly the self-
explanatory “Everyone”—highlight the username, and click the Remove 
button. Now, any user who is not expressly listed here (or included in any 
groups listed here) will not have access to your shared files.

When you’re done, click OK. The changes take effect immediately and 
apply to the selected folder share, as well as to all subfolders and files con-
tained therein.

Share an Entire Drive
THE ANNOYANCE: I looked at the Sharing tab for my C: drive, and the “Share 
this folder” option is selected, meaning the drive is currently being shared. 
However, I don’t see it in My Network Places. What’s going on?

THE FIX: In Windows XP Professional (and Media Center Edition), all drives 
are shared automatically. For instance, the Sharing tab for drive C: on your 
PC probably looks like the one shown in Figure 5-6. (None of this applies 
to Windows XP Home.)

Figure 5-5. Set sharing permissions to 
protect your data from intruders (or just to 
keep the kids from accidentally messing up 
your stuff).

By adding someone else’s 
username to the Permissions 
window, you can protect your 
data without handing over 
your username and password. 
If your PC is part of an NT 
domain (typical in a corporate 
environment), you can add 
users from your domain or even 
another domain by clicking the 
Locations button to change 
the scope of the user valida-
tion. But on a home network, 
you’ll need to create a new user 
account on your PC (using the 
User Accounts control panel) 
before you can type it into the 
Permissions window.

N O T E

In most cases, you won’t have to bother with the checkboxes in the Deny 
column unless you start messing with “groups” of users. Permission to carry 
out a given action is implicitly denied as long as there’s no checkmark in the 
corresponding Allow box.

N O T E

Share an Entire Drive
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Microsoft calls this an administrative share, and it’s enabled by default so 
that tools such as the Computer Management utility (accessed by going to 
Start→Run and typing compmgmt.msc) running on a remote computer can 
operate on your PC. The dollar sign at the end of the share name (e.g., C$) 
identifies it as a hidden share, which means it won’t ever show up in My 
Network Places. All it takes to view a hidden share is to type the share name 
into Windows Explorer’s address bar, like this:

\\mycomp\c$

In this example, mycomp is the name of your computer. Provided there aren’t 
any password or permission restrictions (see “Protect Shared Files”), any-
one can access the files in this shared folder as readily as any non-hidden 
share. (For more on hidden shares, see “List All Your Shared Folders.”)

Figure 5-6. Each hard disk on your PC may already be shared.

Yes, administrative shares indeed constitute a potential security risk, as they 
allow access to any files on your hard disk, whether they’re in folders you’ve 
specifically shared or not. If you want to remove administrative shares for 
good, see “Turn Off Administrative Shares.”

W A R N I N G

 Share an Entire Drive
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Now, you can use these administrative shares to access your drives remote-
ly, as explained earlier, but if you want to share your drive so that it shows 
up in My Network Places, just click the New Share button at the bottom of 
the window. In the New Share dialog box, type a share name (e.g., C), set 
any permissions, and click OK.

List All Your Shared Folders
THE ANNOYANCE: I know a folder is being shared when I see that little hand 
icon on top of the yellow folder icon. But all it takes is one forgotten share 
to leave my private files open to prying eyes. Can I get a comprehensive, 
reliable list of everything being shared on my PC?

THE FIX: You can simply open the My Network Places folder in Windows 
Explorer and navigate through Entire Network to find your PC and a list of 
all its shared resources, but this listing doesn’t necessarily show everything 
that’s being shared. Specifically, any hidden shares are, well, hidden.

To view all your network shares—including the hidden ones—select Start→
Run, type compmgmt.msc, and click OK to open the Computer Management 
tool. In the System Tools branch on the left, click the [+] icon next to 
Shared Folders to expand it, and then highlight the Shares folder, as shown 
in Figure 5-7.

Any share with a dollar sign at the end of its name (e.g., C$) is hidden. 
While hidden shares don’t show up in My Network Places, you can access 
them just as readily as non-hidden shares, as explained in “Share an Entire 
Drive.”

Concerned about security? 
Instead of sharing the entire 
drive, just share the individu-
al folders you need to access 
across your network.

N O T E

Figure 5-7. The Computer Management 
tool lists all the shared folders on your PC, 
including hidden ones you probably didn’t 
even know existed.

List All Your Shared Folders
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From here, you can right-click any share and select Stop Sharing to turn it 
off, making this window a very convenient place to quickly tighten up secu-
rity on your system. If you add or remove any shares in Windows Explorer, 
press the F5 key or click the Refresh button on the toolbar to update the 
list.

Although you can stop sharing any hidden share (such as C$) in this win-
dow, Windows will recreate all administrative shares the next time you start 
your computer, in effect sharing every file on your PC whether you want 
it to or not. To stop this from happening, see “Turn Off Administrative 
Shares.”

Turn Off Administrative Shares
THE ANNOYANCE: Windows insists on sharing my entire hard disk, despite the 
fact that I’ve only elected to share specific folders. What are administrative 
shares, and why can’t I turn them off?

THE FIX: Hmm… it’s almost as though Microsoft cares more about corporate 
strategy than the personal security of their customers. Funny, that.

If you’re using Windows XP Professional (or Media Center Edition), your 
entire hard disk is indeed being shared on your network whether you like 
it or not (see “Share an Entire Drive” for details).  If you open Windows 
Explorer, right-click drive C:, and select Sharing and Security, you’ll see 
that the drive is already shared as C$. This is called an administrative share, 
and although the $ suffix makes it hidden in My Network Places, users on 
your network can still browse the share—thereby gaining access to all the 
files on your drive—by typing the following path into Windows Explorer’s 
address bar:

\\mycomp\c$

where mycomp is the name of your PC. Combine this with the fact that user 
accounts don’t have passwords by default, and you’ll see how insecure 
Windows XP can be. (See “Protect Shared Files” for further steps you 
should take to secure your system.)

Administrative shares allow network administrators to install software, run 
Disk Defragmenter, or perform other maintenance on your PC remotely. 
But unless you’re in a corporate environment, you have nothing to gain by 
leaving this back door open… and everything to lose.

To patch this hole, open the Registry Editor (go to Start→Run and 
type regedit), and navigate to HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\lanmanserver\parameters. In the right pane, 
double-click the AutoShareServer value, type 0 in the “Value data” field, and 
click OK. Then double-click the AutoShareWks value, type 0 in the “Value 
data” field, and click OK. Close the Registry Editor when you’re done.

 Turn Off Administrative Shares
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Next, go to Start→Run, type compmgmt.msc, and click OK to open the 
Computer Management tool. In the System Tools branch on the left, click 
the [+] icon next to Shared Folders to expand it, and then highlight the 
Shares folder (see Figure 5-7 in “List All Your Shared Folders”). To manually 
remove the administrative shares, right-click each one (e.g., C$, D$, E$) 
and select Stop Sharing. Go ahead and remove any hidden share (anything 
with a dollar sign in the name), with the following three exceptions:

 • IPC$, which stands for Inter-Process Communication, is used for 
remote administration of your computer, something very few people 
need outside of a corporate environment. Although it has been proven 
that the IPC$ share can be exploited, the only way to disable it perma-
nently is to turn off file sharing altogether. You can stop sharing IPC$ 
temporarily, but Windows will recreate the share the next time you 
restart.

 • print$ is used to exchange printer driver files when you share a printer. 
You should leave this share intact.

 • wwwroot$ will be present if Microsoft’s Internet Information Server 
(IIS) software is installed. Leave this share intact if you want to use your 
computer as a web server or a web software development platform.

When you’re done, restart your computer, and then reopen the Computer 
Management tool to check your work.

Speed Up Network Browsing
THE ANNOYANCE: It seems to take forever to browse the folders on the other PCs 
on my network. How can I speed things up?

THE FIX: The Scheduled Tasks folder, which appears in My Network Places 
along with your shared folders and printers, is responsible for much of the 
slowdown. Since the shared Scheduled Tasks folder takes so long to load, 
and has very little value to most Windows users, you can just turn off the 
share to speed things up.

Open the Registry Editor (select Start→Run and type regedit), and 
navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\
CurrentVersion\Explorer\RemoteComputer\NameSpace. Inside the 
NameSpace key, you may see one or several subkeys, each responsible for a 
special shared folder. To see what any one of these subkeys does, select it 
and look at the (Default) value in the right pane. 

To stop sharing Scheduled Tasks, just delete the {D6277990-4C6A-11CF-
8D87-00AA0060F5BF} key.

While you’re here, you can further improve performance by turning off the 
Printers and Faxes share. If you don’t plan on sharing any printers, delete 
the {2227A280-3AEA-1069-A2DE-08002B30309D} key.

Speed Up Network Browsing
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Close the Registry Editor when you’re done. The change should take effect 
immediately.

Connect to a Windows 9X/Me PC
THE ANNOYANCE: I have an old Windows 98 system I need to network with my 
Windows XP machine, but I can’t seem to get the two PCs to communi-
cate.

THE FIX: Getting XP to happily communicate with Windows 9x machines 
over a network can be a bit of a chore. Fortunately, there are two tactics that 
usually solve the problem.

First, assign a static IP address to each PC on your network, regardless 
of the Windows version being used; see “Network Two Computers” for 
instructions.

Second, Windows 95 and Windows 98 (and occasionally Windows Me) 
install a driver called NetBEUI by default. NetBEUI is not compatible with 
Windows NT–based systems (such as Windows XP and 2000), and it can 
cause problems if installed on any system on your network. To remove 
NetBEUI from a Windows 95/98/Me system, open the Network control 
panel and choose the Configuration tab. If you see NetBEUI in the list, 
highlight it, and click the Remove button. Remove all instances of NetBEUI 
from this window, and then click OK when you’re done. You’ll probably 
have to restart your PC. 

Find Missing Remote Printers
THE ANNOYANCE: I need to print to a printer that’s physically connected to 
another PC on my network, but when I browse for the printer in the Add 
Printer Wizard, it never shows up. I also tried typing the printer’s network 
address into the wizard without any luck, and the printer manufacturer is 
absolutely no help.

THE FIX: The traditional way to use a printer installed—and shared—on 
another PC is to open the Printers and Faxes control panel and then click 
Add Printer. On the “Local or Network Printer” page, choose “A network 
printer, or a printer attached to another computer,” and on the next page, 
choose “Browse for a printer.” Unfortunately, a variety of problems can 
cause the printer to be absent from this screen.

If, for some reason, you want to re-enable the Scheduled Tasks share, just rec-
reate the subkey. Select Edit→New→Key and type {D6277990-4C6A-11CF-8D87-
00AA0060F5BF} for its name.

N O T E
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First, make sure the PC to which the printer is connected is turned on, the 
network is working for all PCs involved, and the printer is indeed shared. 
On the remote PC (the one with the printer), open the Printers and Faxes 
control panel. Right-click the printer you’d like to share, select Properties, 
and then choose the Sharing tab. Select the “Share this printer” option, and 
then click OK.

If the printer is shared, and you’re sure its driver supports network sharing, 
there’s a quick workaround that usually works (although it won’t solve the 
underlying problem, whatever that might be). Open Windows Explorer 
on a PC not directly connected to the printer, and click the My Network 
Places folder. Open Entire Network, then Microsoft Windows Network, then 
your workgroup (e.g., MSHOME), and then the PC to which the printer 
is attached. Inside, you’ll find a Printers and Faxes folder, and inside that, 
you’ll see all the printers shared on that PC. Right-click the printer you want 
to use, and select Connect.

If all goes well, the printer will show up in the Printers and Faxes dialog in 
10–20 seconds, and you should be able to print to it immediately thereafter.

PC Slows When Accessed over the Network
THE ANNOYANCE: My PC slows to a crawl when someone reads a shared file on 
my hard disk over the network. I need to keep those shared folders active, 
but the performance slowdown interferes with my work. What can I do? 

THE FIX: Although heavy network traffic can bog down a PC, it may indeed be 
nothing more than a hardware problem. Specifically, your network adapter 
may conflict with another hardware device in your system.

If you’re using a desktop PC, shut down Windows, unplug the power cable, 
and crack open the case. Locate your network adapter—the card into which 
you plug your network cable—remove the screw, pull out the card, and 
pop it into a different slot. Reassemble and turn on your PC and see if the 
problem goes away.

If, on the other hand, your NIC is integrated on the motherboard, it prob-
ably shares an IRQ with one of the PCI slots, and thus the PCI card in that 
slot may be causing the problem. Remove all nonessential PCI cards from 
your system, and start up Windows. If the problem persists, you may have 
to shuffle the remaining, essential PCI cards until you resolve the problem. 
If, on the other hand, the problem vanishes after you remove the PCI cards, 
shut down your PC and reinsert the cards one by one, reassembling and 
restarting your system after each insertion, until you find the culprit. If the 
culprit is a troublesome PCI slot, cover it with a piece of masking tape to 
remind yourself to keep it unoccupied.

Note that some printers can’t 
be shared (this problem may 
come up if the manufacturer 
sells a more expensive “net-
work-ready” printer that they’d 
rather have you buy). Review 
your printer’s documentation 
and check the manufacturer’s 
web site for driver updates if 
you can’t get sharing to work. 
Typically, printers suffering 
from this limitation do show up 
in the “Browse for a printer” list 
but display an error when you 
try to install the drivers or print 
remotely.

N O T E
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If you’re still stuck, you may need to update your network drivers or 
even replace your network hardware (see Chapter 6 for other hardware  
annoyances).

Log in Automatically
THE ANNOYANCE: I added a password to my Windows user account to protect 
my shared data, but now I have to type it every time I turn on my PC. Isn’t 
there a way to skip this step?

THE FIX: It may seem ironic to create a password for your PC and then imme-
diately override it with an automatic logon, but it’s a perfect solution for a 
single-user PC on a home network. As described in “Protect Shared Files,” 
your user account needs a password if you want to share files with other PCs 
on your network, particularly if you want to protect your data from intrud-
ers. But unless those intruders routinely walk by your computer, you can 
forgo having to type that password every time you start Windows.

To do this, go to Start→Run, type control userpasswords2, and then click 
OK to open the alternate User Accounts window shown in Figure 5-8. (The 
standard User Accounts window in the Control Panel isn’t sufficient for this 
task.)

Remove the checkmark next to the “Users must enter a 
user name and password to use this computer” option, 
and click OK. In the Automatically Log On dialog box, 
type your username, enter your password twice, and 
click OK. The next time Windows starts, you’ll skip the 
Welcome screen and go straight to your desktop.

Use the Administrator Account
THE ANNOYANCE: When I installed Windows, I had to 
choose an Administrator password and then create 
a separate user account for myself. Can I delete the 
superfluous account and simply use the Administrator 
account as my primary login?

THE FIX: You can, but only in Windows XP Professional 
and Media Center Edition. (Note: in MCE, the 
Administrator account is named “Media Center” by 
default.) In Windows XP Home, the Administrator 
account is restricted and can be used only when you 
start your PC in Safe Mode.

Figure 5-8. Use the alternate User Accounts 
window to do things you can’t do with the 
standard User Accounts window.
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To log in as the Administrator, go to Start→Log Off, and click the Log Off 
button. Once you see the Welcome screen, press Ctrl-Alt-Del twice to show 
the old-fashioned “Log On to Windows” dialog box. Type Administrator for 
the username, enter the Administrator password below, and click OK.

Once you’ve logged on as the Administrator, you can delete the superfluous 
user account from the User Accounts control panel. Of course, you’ll lose 
all the settings from that account, so it may not be worth it if you’ve been 
using the account for some time.

To show the Administrator account on the Welcome screen, open the 
Registry Editor (go to Start→Run and type regedit), navigate to HKEY_
LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\
Winlogon\SpecialAccounts\UserList, select Edit→New→DWORD Value, 
and type Administrator for the name of the new value. Double-click the new 
Administrator value in the right pane and type 1 in the “Value data” field. 
When you’re done, close the Registry Editor and restart Windows for the 
change to take effect.

I N T E R N E T  C O N N E C T I O N S

Get Your PC Online
THE ANNOYANCE: I just signed up for a broadband Internet connection in my 
home. Everything seems to be plugged in correctly, but I can’t get to any 
web sites.

THE FIX: Modern broadband connections are pretty simple, until they stop 
working. Most of the time, the solution involves nothing more than unplug-
ging your cable or DSL modem (and router, if you have one), leaving the 
devices unplugged for at least two full minutes, and then plugging them 
back in. If that doesn’t work, you’ll have to do a little digging.

Examine your DSL or cable modem’s port lights, which will tell you 
whether or not a particular service is working. One should be lit (green, 
usually) when your PC is connected, and another should be lit when your 
broadband is connected. These lights typically flash to indicate that data 
is being transferred. If they’re off, or perhaps red or orange, something is 
wrong with your modem or your connection, and no amount of wrangling 
in Windows will fix it. To see if your modem is to blame, reset it (see your 
modem’s documentation for details) and try again; replace your modem if 

Don’t know the Administrator 
password? Provided you’re 
logged in as a user with admin-
istrator privileges (not the same 
as the Administrator account), 
you can choose a new password 
for the Administrator account 
in the alternate User Accounts 
window (go to Start→Run and 
type control userpasswords2). 
Just highlight any user in the list 
other than Administrator, and 
then click the Reset Password 
button.

N O T E

If you don’t yet have a router, consider getting one as part of the solution to 
this problem. As described in “Set Up a Wireless Network,” routers offer better 
firewall protection than Windows can; they also take care of a lot of the prob-
lems that commonly plague broadband connections, such as finicky dialers.

N O T E
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it won’t respond even after a reset. If your modem checks out, your connec-
tion might be down; give your ISP an hour or two to bring your service back 
up, and contact them if it takes any longer.

Does your broadband connection require special dialer software? See the 
“Troubleshoot Your Dialer” sidebar for dialer-specific help. Otherwise, 
you likely have an always-on connection, one that uses either a dynamic 
(randomly assigned) IP address or a static (always the same) IP address. In 
this case, refer to the paperwork that came with your broadband connec-
tion, and change Windows’s TCP/IP settings accordingly, as described in 
“Network Two Computers.” Specifically, choose the “Obtain an IP address 
automatically” option if you’re using a dynamic address, or the “Use the 
following IP address” option for a static address.

Get Rid of Third-Party Dialers
THE ANNOYANCE: My ISP gave me this CD when I signed up for Internet service. 
Not knowing any better, I installed it, and now my PC is littered with ads 
and junk software. Do I need any of this stuff?

THE FIX: In most cases, the software that comes with broadband service is 
unnecessary, providing little more than branded web software and links 
to your ISP’s various marketing partners. The exception is the “dialer” 
program required by certain types of broadband connections, which is 
used to send your username and password to your ISP in order to connect 
to the Internet. Such software is typically flaky and the cause of all sorts 
of Internet connection problems. Fortunately, you can usually dump your 
ISP’s proprietary software in favor of either Windows XP’s built-in dialer or 
the auto-connect capabilities of a router.

First, remove the superfluous software provided by your ISP: in the Add or 
Remove Programs control panel, highlight your ISP’s software, and click the 
Remove button. If your ISP installed more than one software package, you 
may have to uninstall several entries from this list.

Troubleshoot Your Dialer
If you’re still using the software that 
came with your router, see “Get Rid 
of Third-Party Dialers” for an alter-
native that may work.

Whether you use a router, XP’s 
own Point-to-Point over Ethernet 
(PPPoE) dialer, or your ISP’s dialing 
software to connect, the way your 
dialer behaves when you try to con-
nect should tell you what’s wrong. 
If it tells you that your login is incor-
rect, either your username or your 
password is wrong. The most com-
mon mistake involves the username, 
which often resembles an email 
address (e.g., username@myisp.net) 
instead of just a bare name. Check 
your documentation for details, or 
call your ISP to have them reset your 
password.

If you have to wait a long time 
before the dialer gives you any 
error at all, your IP settings may 
be incorrect; see “Network Two 
Computers” for the fix. If, on the 
other hand, you get an error right 
away, it’s probably a configuration 
problem with your dialer software, 
such as the wrong network adapter 
selected.

If your dialer indicates that there 
was no response from the server (or 
something similar), it usually means 
your service is down. Check your 
cables, and contact your ISP for 
status.

There are a few exceptions. If you’re using a USB modem, such as the 
SpeedTouch 330, it may require special drivers in order to work. If you have 
one of these, you may be better off replacing it with a combination modem 
and wireless router, such as the SpeedTouch 580, than trying to get it to work 
with anything other than the software that comes with it. Another exception 
is a wholly proprietary Internet connection provider such as AOL, which isn’t 
compatible with anything other than the provided connection software.

N O T E

Internet Connections
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The best alternative to a software-based dialer is a wireless router, which 
will dial your connection automatically, keep you online all the time, pro-
tect your PC with its built-in firewall, and even provide wireless access to 
boot (see “Set Up a Wireless Network” for details). 

Although routers are hard to beat, you can use Windows’s built-in PPPoE 
dialer to connect to the Internet without any added hardware. Open the 
Network Connections control panel and click the “Set up a home or small 
office network” link on the left (or double-click the Network Connection 
Wizard icon). Answer the questions as follows:

 1. Click the Next button to skip the introductory page, choose the 
“Connect to the Internet” option, and then click Next again.

 2. Choose the “Set up my connection manually” option, and click Next.

 3. Choose the “Connect using a broadband connection that requires a 
user name and password” option, and click Next.

 4. Type a name for this connection, and click Next. A good choice is the 
name of your ISP, or just “DSL” or “cable.”

 5. Enter your username and password (see Figure 5-9), choose the desired 
options underneath (if you’re not sure, turn them all on), and click 
Next.

 6. Click the Finish button to complete the wizard.

Figure 5-9. Use the Network Connection Wizard to set up a PPPoE dialer and replace the dialer that 
came with your broadband modem.
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To initiate the connection, double-click the icon you just created in the 
Network Connections folder. If you elected to create a desktop shortcut in 
the wizard, you can also double-click the new desktop icon. By default, a 
Connect dialog will appear, at which point you can click the Connect but-
ton to dial and connect your PC to the Internet.

Normally, you’ll have to dial this connection before you can go online. To 
have Windows connect automatically, first right-click the connection icon 
and select “Set as Default Connection.” Next, open the Internet Options 
control panel, choose the Connections tab, and select the “Always dial my 
default connection” option.

To skip the Connect dialog, right-click the new connection and select 
Properties (or click the Properties button in the Connect dialog box). 
Choose the Options tab, and remove the checkmark next to the “Prompt for 
name and password, certificate, etc.” option. This is particularly useful if 
you want Windows to connect automatically when you first start your com-
puter; just drag the PPPoE connection icon from the Network Connections 
folder into your Startup folder in your Start menu.

Share an Internet Connection
THE ANNOYANCE: I have three PCs in my house, but only one Internet connec-
tion. How can I access the Web from all three PCs at the same time?

THE FIX: There are several approaches, but the best solution is to use a router 
(preferably one with wireless support). Essentially, you take the cable that 
goes from your modem to your PC, unplug it from your PC, and plug it into 
the back of the router. Then you connect all your PCs to your router, either 
wirelessly or with cables, and then configure your router, as described in 
“Set Up a Wireless Network.” The router also protects the PCs on your 
network with its built-in firewall, a must-have in an era of viruses, spyware, 
and bored teenage hackers.

The alternative to a router, useful only if you need a quick-and-dirty solu-
tion or can’t use a router for some reason, is to use Windows XP’s built-in 
Internet Connection Sharing (ICS) feature. The trick, basically, is to con-
nect one PC (called the “host”) simultaneously to the Net and to your local 
network. Then you set up your other PCs to piggyback, so to speak, on the 
host PC’s Internet connection. Since the host PC needs two network cards, 
(one for the local network and one for connecting to the Internet), this 
approach likely won’t save you any money—or time, for that matter—over 
using an inexpensive router. 

To set up ICS on the host PC, open the Network Connections control panel 
and select View→Details. You should have at least two connections listed: 
one for your Internet connection and one for your workgroup. If not, your 
network is not ready.

Internet Connections

 Share an Internet Connection
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Find your connection for the Internet. In most cases, this connection will 
be the network adapter connected to your DSL or cable modem. (For con-
nections that require a username and password, use the PPPoE broadband 
connection you set up in “Get Rid of Third-Party Dialers.”) Right-click the 
connection icon, select Properties, and choose the Advanced tab. Check 
the “Allow other network users to connect through this computer’s Internet 
connection” box, and click OK. Back in the Network Connections folder, it 
should now say “Enabled, Shared” in the Type column.

The next step is to configure each of the other computers on your network 
to use the shared connection. On each of the other “client” PCs, open the 
Network Connections control panel, right-click the connection icon corre-
sponding to the network adapter plugged into your workgroup, and select 
Properties. Choose the General tab, highlight the “Internet Protocol (TCP/
IP)” entry in the list, and click the Properties button. In most cases, you’ll 
want to select the “Obtain an IP address automatically” option. If, however, 
you need static IP addresses, choose the “Use the following IP address” 
option, and fill out the fields as instructed in “Network Two Computers”. 
For the “Default gateway,” type the IP address of the PC hosting the shared 
Internet connection.

That’s it! Test your connection on each PC by loading a web page. Of 
course, for this to work, the host computer must be turned on and con-
nected to the Internet—a requirement that makes the router a much better 
choice for the long haul.

Measure Your Internet Connection Speed
THE ANNOYANCE: I’m not sure I’m getting the best speed from my Internet con-
nection, but the Connection Status window in Windows XP doesn’t give me 
any useful information. And while I’m at it, are the ads I’ve seen for “faster” 
Internet connections mostly hype, or is there something I can do to improve 
my connection speed without spending any extra cash?

THE FIX: Throughput is the practical measurement of bandwidth: the quan-
tity of data you can transmit over a connection in a given period of time. 
The simplest way to measure your throughput is to visit one of the many 
bandwidth-measuring web sites, such as Broadbandreports.com (http://
www.dslreports.com/stest/) or Bandwidth Place (http://bandwidthplace.
com/speedtest/).

For the most accurate results, make sure you close all superfluous programs 
before running the test. In addition to calculating your bandwidth and 
reporting the results, these services typically ask for your Zip Code and 
connection type to compile statistics on typical connection speeds in your 
area. The results should look something like Figure 5-10.

Measure Your Internet Connection Speed
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Now, according to the results in Figure 5-10, the download speed is a 
respectable 1267 kbps (kilobits per second), which means, in practical 
terms, that it should take about 6.5 seconds to download a 1-MB file under 
ideal conditions.

However, ideal conditions are rare; real-life transfers are often much slower, 
due to overburdened servers and busy networks. Since your connection 
speed (or lack thereof) is most noticeable during file downloads (compared 
with web surfing or emailing), you can overcome some of these conditions 
by using a download manager, as described in “Faster Downloads Without 
the Hassle” in Chapter 4.

So what do you do if your connection seems too slow? First, close all open 
windows, and turn off all background programs (such as the ones that 
show up in the System Tray in the lower-right corner of the screen, near the 
clock). Do the same for any other PCs using your Internet connection. Next, 

Figure 5-10. Use Broadband Reports’s 
speed test page to measure the speed of your 
Internet connection.

Internet Connections
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examine the lights on your router or broadband modem; if they’re flashing, 
it means that some program is still running on your PC, possibly consum-
ing bandwidth. This is a possible sign that a virus, worm, Trojan horse, or 
some sort of spyware has made its way onto your PC (see “Put an End to 
Pop-ups” in Chapter 4), but see the “Overcome a Bandwidth Limit in SP2” 
sidebar for another possibility.

Of course, it’s also possible that you’re hitting the upper limit of your broad-
band connection. But whether or not an upgrade from your ISP is worth 
the money depends on the bandwidth you’re getting now and the amount 
of cash your ISP is demanding for the faster service. If your connection 
measures more than one megabit per second (1024 kbps), it’s unlikely you’ll 
notice a huge difference in real-world speed with a faster connection. On 
the other hand, more expensive connections sometimes offer substantially 
higher upload speeds, which may be worth the added cost if you spend a lot 
of time sending files to web servers, or even if you want to host a web site 
on your PC.

Make Peer-to-Peer File Sharing Work
THE ANNOYANCE: My peer-to-peer (P2P) file-sharing program stopped working 
when I installed Service Pack 2. Is Microsoft trying to put an end to P2P, or 
can I fix this?

THE FIX: Most large companies would like to see P2P disappear, mostly 
because nobody has found a respectable way to make money off it. But 
the problem you’re experiencing is almost certainly caused by the new 
Windows Firewall software built into SP2, which is blocking your file-shar-
ing program from establishing a connection to its server.

For real-time monitoring of your connection’s throughput, try a desktop 
bandwidth monitor. The slickest tools are widgets, fancy plug-ins for the free 
Kapsules script engine (http://www.kwidgets.com) For instance, Bandwidth 
Watcher, Simple Bandwidth Monitor, Mr. Network, and KapMule, all avail-
able at http://www.kwidgets.com/forge.aspx, provide pretty graphical displays 
and up-to-the-second measurements of the amount of data being transferred 
via your Internet connection.

N O T E

Overcome a 
Bandwidth Limit in 

SP2
There’s a little-known change 
in Service Pack 2 that limits 
the number of concurrent 
open TCP/IP connection 
attempts to 10. This may 
adversely affect programs 
that use multiple TCP/IP con-
nections, such as some down-
load managers, port scanners, 
and P2P software (and, by 
design, viruses).

To see if this is happening 
on your system, open the 
Event Viewer (select Start→
Run and type eventvwr.msc), 
and highlight the System 
entry in the left pane. In the 
right pane, click the Event 
column header to sort the list 
by event code, scroll through 
the list, and look for 4226 
errors. If you see any 4226 
events, you can fix the prob-
lem by downloading a patch 
for your tcpip.sys file (sorry, 
no Registry change here) by 
going to http://www.lvllord.
de/?url=tools#4226patch. 
Note that only advanced 
users should attempt this. 

If you’re using a router, visit the manufacturer’s web site for a possible firm-
ware update that might fix some performance problems and may even add new 
features to your router.

N O T E
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A firewall is a layer of protection that permits or denies network communica-
tion based on a predefined set of rules. These rules restrict communication 
so that only certain applications are permitted to use your network connec-
tion. This effectively closes back doors to your computer that viruses, hack-
ers, and other malicious parties or applications might otherwise exploit. 
The Windows Firewall (see Figure 5-11) replaces the nearly worthless 
Internet Connection Firewall (ICF) found in earlier versions of Windows 
XP. While it’s better than its predecessor, it also acts more aggressively and 
closes more back doors by default. (See “Set Up a Wireless Network” for 
more information about firewalls.)

Microsoft frequently releases 
updates and bug fixes for its 
firewall. If you decide to use 
the Windows Firewall, make 
sure you download all available 
updates using the Windows 
Update feature. 

N O T E

Figure 5-11. The Windows Firewall, which is turned on by default in Windows XP Service Pack 2, is 
known to cause problems.

If you’re using a router with a built-in firewall and you don’t need to protect 
your PC from the other computers in your local network, you can safely turn 
off the Windows Firewall for good.

N O T E
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To see if the Windows Firewall is to blame, disable it temporarily. Open the 
Security Center control panel, click Windows Firewall, select the “Off (not 
recommended)” option, and click OK.

If your P2P software now works, the firewall software is clearly the cul-
prit. (If it still doesn’t work, the problem lies elsewhere; consult your P2P 
software documentation for details.) Go ahead and return to the Windows 
Firewall window, and select the “On (recommended)” option to re-enable 
it. Next, choose the Exceptions tab, click the Add Program button, and find 
your P2P application in the list (if you don’t see it, click Browse to locate the 
.exe file on your hard disk). Highlight the program and click OK in both 
boxes. The Windows firewall should now let your P2P program do its thing 
without interference—the change will take effect immediately. (If you’re 
using a third-party firewall program, check the software’s documentation 
for help creating exceptions.)

If creating this exception doesn’t work, return to the Exceptions tab of the 
Windows Firewall window and create another exception. This time, instead 
of basing the exception on the program filename, configure the firewall to 
allow all communication over the port used by your software. Click the Add 
Port button, type a name for the exception (for example, P2P), and type the 
port number (e.g., 6699). If you don’t know the port number used by your 
P2P software, consult the software documentation. Click OK in both boxes, 
and give it a whirl.

Use MSN Messenger Behind a Firewall
THE ANNOYANCE: I want to use MSN Messenger at work, but my company’s 
firewall blocks instant-messenger software. How can I get around this?

THE FIX: The last thing you should be forced to do when you’re at work is your 
job. To that end, several web-based versions of popular IM programs have 
been designed that can sneak through firewalls quite easily. (Such programs 
operate over TCP port 80, and are thus indistinguishable from web sites in 
the eyes of the firewall.)  In the case of MSN Messenger, just go to http://
webmessenger.msn.com and click “Start MSN Web Messenger” to log in. 

Use MSN Messenger Behind a Firewall
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W I R E L E S S  C O N N E C T I O N S

Set Up a Wireless Network
THE ANNOYANCE: I can’t get my wireless network off the ground. I want to use 
the Internet, share files, and so on, but none of it seems to work. I thought 
this was going to be easy! 

THE FIX: Wireless networking is easy! (Unless it’s not.)

Wireless networking can be extremely convenient when it works but an 
absolute headache when it doesn’t. The good news is that if you take the 
time to set up your router correctly, update your firmware, and install 
Service Pack 2, most wireless problems will disappear.

A router lets you connect your PC (or all the PCs in your workgroup) to the 
Internet, as well as connect multiple PCs to each other. Routers also include 
built-in firewalls, offering much better protection than software-based 
firewalls such as the Windows Firewall built into Service Pack 2. But most 
importantly, a wireless router acts as an access point, a central hub to which 
all wireless devices in your home or office can connect. To set up a wire-
less network, you’ll need a wireless router (preferably one that supports the 
802.11g standard), and at least one PC with a wireless network adapter. 

Connect your PC directly to your wireless router with a cable; that’s right, a 
cable! You’ll need to communicate with your router to set it up properly for 
wireless access—something you won’t be able to do wirelessly throughout 
the whole process. Connect one end of a category-5 patch cable to your PC’s 
Ethernet port, and the other end to one of the numbered LAN ports on the 
back of the router. Then plug in the router’s power cable.

Your router probably came with setup software on a CD; in most cases, 
you don’t need this and can use the router’s more flexible web-based setup 
instead. Open a web browser on your PC, and type the router’s IP address 
(usually 192.168.1.1, but check the router’s manual) into the address bar. 
The router’s built-in web server should show you a setup page like the one 
in Figure 5-12.

If you can’t connect to your router, your computer is probably not on the 
same subnet as the router. The first three numbers of your computer’s IP 
address must match the first three numbers of your router’s IP address, but 
the fourth number must be different. For instance, if your router’s address is 
192.168.0.1, you may not be able to connect to it until you manually change 
your PC’s address to 192.168.0.xxx, where xxx is any number between 2 
and 255 (see “Network Two Computers” for further instructions). If all else 
fails, reset the router, following the instructions in the documentation, and 
try again.

If you don’t have Service Pack 
2 yet, use the Windows Update 
feature now to get it (open 
Internet Explorer and select 
Tools→Windows Update). See 
Chapter 6 for more informa-
tion about SP2 and Windows 
Update.

N O T E
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On the setup page, choose your Internet connection type from the list. If 
your Internet connection requires a username and password, select PPPoE. 
If your ISP has provided an IP address for your connection, select Static 
IP. Otherwise, choose Automatic Configuration - DHCP. (Naturally, the 
options for your router may be slightly different.)

Click the Apply or Save Settings button at the bottom of the page when 
you’re done. Within a few seconds, you should have Internet access; go 
ahead and test it by opening a second browser window (press Ctrl-N) and 
visiting any web site.

Once your Internet connection is working, visit the router manufacturer’s 
web site and download any available firmware updates. (You can usually 
find your router’s current firmware version on the Status page in the router’s 

Figure 5-12. Configure your router via its 
web-based setup page.

If you select PPPoE, the rout-
er should prompt you for a 
login. Type the username and 
password for your broadband 
connection, not your login for 
Windows, your email account, 
or anything else. If you choose 
Static IP, enter the IP addresses 
of your ISP’s DNS servers. Your 
ISP should provide this infor-
mation to you.

N O T E
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web-based setup.) Firmware updates include essential bug fixes, perfor-
mance enhancements, security patches, and occasionally new features. 
Consult your router’s documentation for firmware update instructions.

Next, go to your router’s wireless setup page (see Figure 5-13): this is either 
a link in the main menu or a tab across the top of the page. Choose a new 
SSID (the name for your wireless network), and turn off the Wireless SSID 
Broadcast option to keep your wireless network private (see the sidebar 
“The Evils of SSID Broadcast” for details). Click the Apply or Save Settings 
button at the bottom of the page when you’re done.

Figure 5-13. Choose a private SSID in your 
router’s wireless setup page.

If you’re using a Wireless-G router (a faster sibling of the 802.11b standard, 
capable of 54 Mbps), avoid the temptation to select the “G only” option on 
the wireless setup page. This feature prevents slower Wireless-B devices from 
joining your WiFi network—a fact you’ll likely have forgotten when a visiting 
relative tries to connect to your home network to check her email a few months 
from now.

N O T E
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You should also enable encryption for the best wireless security. This set-
ting will be accessible either through a button on the current page, or on a 
separate tab entitled WEP, WPA, Encryption, or simply Wireless Security, 
like the one in Figure 5-14. WEP, the Wireless Encryption Protocol, pre-
vents anyone without your secret WEP key from connecting to or spying on 
your wireless network. Some routers also support WPA, or WiFi Protected 
Access, which provides a slightly higher level of security.

On your router’s encryption page, enable WEP, and then choose the highest 
WEP encryption level supported by your router (in this example, 128-bit). 
Higher levels provide better protection, but also mean longer (and harder 
to type) WEP keys.

Some routers have you choose a passphrase, which is a word your router uses 
to generate the WEP keys. In the example shown in Figure 5-14, I typed the 
word “annoyances” and clicked the Generate button to create four 26-digit 
WEP keys (the first one, Key 1, is the only one that is used). Generally, all of 
the computers on your wireless network will have to use the same key. 

Figure 5-14. Enable encryption for the best 
wireless security.

Set Up a Wireless Network
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When you’re done, click the Apply or Save Settings button at the bottom of 
the page, and then remove the cable connecting your PC to your router. 

The next step is to enter one of the keys into each computer connected to 
your wireless network, as described in “Connect to a Wireless Network.”

If you have trouble connecting to the router wirelessly, you probably entered 
the WEP key incorrectly. To fix the problem, either reconnect using a cable 
and change the settings or, as a final resort, reset the router as described in 
your router’s documentation.

Connect to a Wireless Network
THE ANNOYANCE: I think I set up my wireless router correctly, but my PC doesn’t 
see it.

THE FIX: You probably turned off your router’s SSID broadcast feature, as 
instructed in “Set Up a Wireless Network.” While this means that strangers 
using WiFi sniffers (described below) won’t “discover” your network, it also 
means that your network won’t show up when you scan for it, either.

To test this, open the Network Connections control panel and double-click 
your unconnected wireless connection to open the “Choose a wireless net-
work” dialog box shown in Figure 5-15. 

The Evils of SSID 
Broadcast
Your SSID is the back door into your 
wireless network. If you broadcast 
your SSID, anyone with an SSID 
sniffer will be able to find it in a 
matter of seconds, connect to your 
network, and use your Internet con-
nection (or even snoop around your 
shared folders).

The same danger exists if you con-
tinue to use your router’s default 
SSID; probably a million people 
around the globe are using “link-
sys,” which makes it a good guess 
for anyone trying to gain access to 
your network. Choose an SSID like 
you’d choose a password, and your 
wireless network will stand a better 
chance of remaining private.

The only time you’ll likely want to 
enable SSID broadcast, other than 
for testing purposes, is if you’re set-
ting up a public WiFi access point, 
say in a coffee shop or bed and 
breakfast, and you want to make it 
easy for your patrons to connect.

Before you save your changes, take this opportunity to record your key in a file 
to simplify the subsequent setup of your PCs. Highlight the first key (Key 1), 
and press Ctrl-C to copy it. Then open your favorite text editor (e.g., Notepad), 
and press Ctrl-V to paste it into a new, empty document. Save the file on your 
desktop.

N O T E

Figure 5-15. The Wireless Network 
Connection dialog shows all WiFi access 
points within range (except the hidden 
ones).

Wireless Connections

 Connect to a Wireless Network
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(You can also right-click the wireless connection icon in your System Tray 
or in the Network Connections window and select View Available Wireless 
Networks.) This window, Windows XP’s built-in “sniffer,” scans for WiFi 
access points within range and displays the results, typically in less than 
five seconds. (See the “Drive-by Sniffing” sidebar for more uses for this 
window.)

To connect to any visible network in the list, highlight it and click the 
Connect button. If your wireless network doesn’t show up, simply click 
the “Set up a wireless network for a home or small office” link on the left 
to start the Wireless Network Setup Wizard (also accessible directly in the 
My Network Places folder). Click the Next button on the first page. On the 
“Create a name for your wireless network” screen, type your wireless net-
work’s SSID in the “Network name (SSID)” field (see Figure 5-16). If you’ve 
enabled WEP or WPA encryption for your router, select the “Manually 
assign a network key” option. If you selected WPA encryption in your 
router’s setup, place a checkmark by the “Use WPA encryption” option; 
otherwise, for WEP, leave it unchecked. Then click Next.

On the next page, turn off the “Hide characters as I type” option to make 
the text fields here easier to deal with. Now, if you’ve saved your WEP key 
from the router setup page (see “Set Up a Wireless Network”), you can open 

The Ethics of WiFi
Thanks to Windows XP’s built-in 
WiFi sniffer, it’s easy to detect and 
connect to any unsecured wireless 
network—including the network of 
an unsuspecting neighbor, which 
raises the thorny issue of ethics. 

There are countless personal wire-
less networks around the globe, and 
most of them, you’ll find, are unse-
cured. This means that if you walk 
down the street in a populated area, 
you’ll probably find a working wire-
less Internet connection before you 
reach the end of the block. Some 
will have been left open intention-
ally, but most will be unsecured 
merely because their owners don’t 
have the benefit of the advice in this 
chapter. 

Now, just because you can connect 
to these networks, does it mean you 
should? Are you taking advantage 
of someone else’s ignorance by 
breaking into their private network, 
or are you simply making use of a 
public resource that you’d be equally 
eager to share?

I’m not about to try to solve this 
dilemma in these short pages; I only 
wish to raise the question, and to 
suggest that if you do ever decide to 
utilize someone else’s wireless net-
work, you make sure to do no harm. 
Think about your impact, both on 
the bandwidth of the foreign net-
work and the privacy of those who 
operate it. And then tread lightly.

—From Windows XP Annoyances 
for Geeks, 2nd Edition

Figure 5-16. To connect to a hidden wireless network, type its SSID into the Wireless Network Setup 
Wizard.

Connect to a Wireless Network
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the file, highlight the key, press Ctrl-C to copy the text, and then click in the 
“Network key” field and press Ctrl-V to paste in the text. Otherwise, you’ll 
have to type in the key from your router setup page manually. Unless you 
feel like typing this long key twice, just copy and paste it into the second 
field, and then click the Next button.

Finally, the wizard gives you the opportunity to save your settings to a USB 
flash drive, theoretically making subsequent setups easier (why no option 
exists to save settings to a CD writer, floppy drive, or simply a file on your 
desktop is a mystery). If you don’t have a USB flash drive handy, or if you 
don’t need to set up any more computers, choose the “Set up a network 
manually” option. Click Next and then Finish when you’re done.

From now on, your wireless network will show up in the “Choose a wireless 
network” list on this PC (as long as it’s in range), even if you’ve chosen not 
to broadcast your SSID. You probably won’t see it right away, though; just 
wait a few seconds and then click the “Refresh network list” link on the left. 
Your network should appear at the top of the list, proudly signifying that 
it has established a connection. You can now open a web browser and test 
your new wireless connection.

If you don’t see the network, you either mistyped the SSID, or your wire-
less router isn’t properly set up. If the network shows up but Windows can’t 
connect, you likely mistyped the encryption key. If, after repeated attempts, 
you can’t connect, disable encryption in your router and try again. You can 
usually fix such problems by updating the firmware in your router, as well 
as the firmware and drivers for the wireless card in your PC.

Surf Safely at the Coffee Shop
THE ANNOYANCE: I like to sit at my local coffee shop with my wireless laptop, sip 
a double decaf soy latte, and read my email. Is this safe?

THE FIX: Good question, and not one that occurs to a lot of people. Soy lattes 
can be risky if you don’t take proper precautions.

Now, when you connect to the WiFi hotspot at the coffee shop (or on some 
random street corner downtown), you’re connecting to a public, unsecured 
workgroup. This may not seem like a problem until you consider the other 
PCs that also may be connected, any of which may share a virus or two with 
you, or merely serve as a conduit for an intruder hacking into your system.

To improve your security, first turn off any and all shared folders (see “List 
All Your Shared Folders”). And if you haven’t done so already, set up a pass-
word for your user account, as described in “Protect Shared Files.” This will 
go a long way toward protecting your data from casual intrusions, but you 
shouldn’t stop there.

 Surf Safely at the Coffee Shop

Wireless Connections
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To be on the safe side, enable the Windows Firewall (see “Make Peer-to-
Peer File Sharing Work”) or install more competent third-party firewall 
software, such as ZoneAlarm Pro ($49.95, http://www.zonelabs.com). The 
best solutions allow you to easily switch between a relaxed state, permitting 
all your programs to work while you’re safely behind your router’s firewall 
at home, and a heightened state of security when you’re on the road.

Of course, mind what you do on the Net while you’re at that coffee shop, 
too. As long as you’re using someone else’s network, nothing you do should 
be considered private. Although secure SSL-protected web sites do provide 
better privacy than insecure sites, you’re probably better off visiting finan-
cial web sites only when you’re at home. 

Increase Range and Improve Reception
THE ANNOYANCE: My laptop connects to the Internet without any problem 
as long as I’m in the same room as my wireless router. But once I change 
rooms or move too far away from my router, the connection drops in and 
out. What’s the deal?

THE FIX: Interference is the name of the game. The tiny WiFi transceiver in 
your PC should be capable of picking up any wireless network within about 
300 feet under ideal conditions—namely, outdoors with a clear line of sight. 
Indoors, the range can be quite a bit lower; typically, the signal won’t go 
through more than two or three walls, and perhaps one floor or ceiling.

Drive-by Sniffing
Every WiFi-equipped PC is capable of WiFi sniffing: scanning the area imme-
diately surrounding it and listing any hotspots (wireless network access points) 
it finds. Of course, only those networks that are broadcasting their SSIDs will 
show up, which is why you’ll probably want to turn off SSID broadcast on 
your own router (see the “The Evils of SSID Broadcast” sidebar).

The “Choose a wireless network” dialog box is Windows XP’s built-in WiFi 
sniffer, and it is particularly handy when you’re trying to find an Internet 
connection away from home. Whether you’re in a coffee shop, in a hotel, or 
just driving through some residential neighborhood, you can use the sniffer 
to list any available WiFi networks within range. The closest networks (or 
rather, the ones with the strongest signals) are listed first, followed by the 
weaker, more distant hotspots.

A yellow padlock icon indicates secure hotspots—wireless networks requir-
ing WEP or WPA security keys—so highlight the unsecured network with 
the strongest signal, and click the Connect button. With any luck, Windows 
should connect to the network in 10–15 seconds, and you should be able to 
start surfing normally soon thereafter.

If you’re concerned about your own privacy when using someone else’s hot-
spot, see “Surf Safely at the Coffee Shop.”

Increase Range and Improve Reception
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The placement of your wireless router and the arrangement of nearby 
obstacles will have a significant effect on the strength and range of your 
WiFi signal. Of course, your router will need to be within spitting distance 
of your DSL or cable modem, but with a sufficiently long cable, you should 
have some leeway with the router’s placement. Use the signal strength indi-
cator in the “Choose a wireless network” window (right-click the wireless 
connection icon in the System Tray or Network Connections window and 
choose View Available Wireless Networks) to test various configurations 
(see Figure 5-15 in “Connect to a Wireless Network”).

Now, other technology in your home or office may also interfere with your 
wireless network, limiting its range, speed, and reliability. Both the popu-
lar 802.11b and newer 802.11g standards operate over the 2.4-GHz band, 
which is also inhabited by many cordless phones and all microwave ovens. 
(The black sheep of the family, 802.11a, solves this problem by using the 5-
GHz band, but its short range and limited compatibility make it an unpopu-
lar choice.) This means that you’ll get better results if you move the router 
away from any cordless phone base stations, televisions, radios, security 
systems, or TV dinners. (Better yet, replace your aging 2.4-GHz portable 
phone with a WiFi-friendly 5.8-GHz cordless phone.)

If, after adjusting the placement of your router, you still need more range, 
consider either a repeater (range extender) or an aftermarket antenna (pro-
vided your router has an antenna port to accommodate one). If you need 
a lot more distance (possibly at the expense of some versatility)—and you 
fancy yourself a tinkerer—a Pringles “cantenna” (http://www.oreillynet.
com/pub/wlg/448) can extend your wireless range by a mile or more! 

Turn Off “Not Connected” Messages
THE ANNOYANCE: Every time I turn on my PC, a little yellow balloon pops up 
in the lower-right corner of my screen and says that my network cable is 
unplugged. I’m not using a network cable at all, and my wireless connection 
works fine. Does this error mean anything?

THE FIX: Not really. It’s kind of like the flight attendant who wakes you up 
during a long flight to ask if you want a pillow (no offense intended to flight 
attendants… or pillows).

Windows XP is designed to notify you whenever one of your network con-
nections isn’t connected, even when another connection is working fine. 
Common sense would tell you to open the Network Connections control 

Like to stay mobile? Keep an eye 
on your wireless reception with 
the free Wireless Strength wid-
get (http://www.widgetforge.
com/?w=58), a graphical signal 
strength meter that sits on your 
desktop. (This tool requires the 
Kapsules scripting engine, free-
ly available from http://www.
kwidgets.com.)

N O T E

Place your wireless router out in the open; don’t put it under your desk, in a 
drawer, or behind a metal file cabinet. If you’re feeding several PCs, place your 
router in a central location. Consider cabling any stationary computers to 
optimize the placement of the router for your portable (wireless) ones.

N O T E
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panel, right-click the connection in question, choose Properties, and 
uncheck the “Notify me when this connection has limited or no connectiv-
ity” box. However, this seemingly apt option has no effect on this error.

Unfortunately, the only way to permanently do away with this useless 
message is to disable the offending connection entirely. Open the Network 
Connections control panel, right-click the connection, and select Disable. 
You’ll notice that both the message and the icon in your Tray disappear, 
never to be seen again (unless you re-enable the connection).

Connect PCs Wirelessly Without a Router
THE ANNOYANCE: My sister and I both have wireless laptops, but we’re traveling 
and nowhere near a wireless router. Can we connect to each other anyway?

THE FIX: Yes you can, using something called an ad-hoc wireless network, 
a little-known feature specifically designed to connect two PCs to one 
another wirelessly.

On one of the PCs, open the Network Connections control panel, right-
click your wireless connection, and select Properties. Choose the Wireless 
Networks tab, and click the Add button to display the Wireless Network 
Properties dialog box shown in Figure 5-17.

Figure 5-17. Create an ad-hoc network to connect two PCs wirelessly without a router or nearby WiFi 
hotspot.
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Type a name for your ad-hoc network in the “Network name (SSID)” field. 
From the Network Authentication drop-down list, choose Open, and from 
the Data encryption list, choose WEP.

Next, remove the checkmark next to the “The key is provided for me auto-
matically” option, and then make up a key to type into both the “Network 
key” and “Confirm network key” fields. The key can be any combination of 
numbers and letters from A–F; for the sake of simplicity, use a 10-character 
(64-bit) key.

Finally, place a checkmark next to the “This is a computer-to-computer (ad 
hoc) network; wireless access points are not used” option at the bottom 
of the window, and then click OK. The new network should show up in 
the “Preferred networks” list, along with the word “(Automatic),” signify-
ing that Windows will connect to this network automatically when it is in 
range.

Now, repeat these steps on the other PC, and then open the “Choose a 
wireless network” dialog box on both PCs (see “Connect to a Wireless 
Network”). With any luck, and a few clicks of the “Refresh network list” 
link, the two PCs should connect and form a private workgroup. To set it 
up so you can exchange files between the two PCs, see “Share Files with 
Other Computers.”

Wireless Connections
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